
Instalación en Windows
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Introducion

Como xa se dixo, vaise instalar, por separado, os seguintes compoñentes en Windows 8.1 Enterprise 64 bits.• 

A razón de instalar cada compoñente por separado é que nos vai permitir ter un maior control de todo canto se precisa e ademais vai poder
permitir que cada lector instale os compoñentes que precise en función dos que xa ten instalados.

• 

Compoñentes:• 

O JDK (Java Development Kit) de Oracle.
Como xa se indicou vaise instalar o JDK no canto do JRE (MV de Java), por se alguén desexa programar a maiores en Java en
consola ou con outros IDEs.

O IDE (Integrated Development Enviroment) de Eclipse.

O SDK (Software Development Kit) de Android

O ADT Plugin (Android Development Tools) para Eclipse. Permitirá facer uso dende o IDE do SDK de Android.

Instalación JDK de Oracle

No material instalouse a versión 7, pero pódese instalara a actual 8 (Outubro 2014).• 
En http://www.oracle.com/technetwork/java/javase/downloads/index.html pódese obter máis información.• 

Instalación JDK• 
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No enlace http://www.oracle.com/technetwork/java/javase/downloads/index.html descargamos o JDK.

• 

Aceptamos a licencia e descargamos a última versión do JDK para windows, neste caso para 64 bits.

• 

• 
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Ficheiro descargado sen extensión.

Se fóra necesario ... engadir extensión .exe

• 

Executar.

• 

Aceptar a advertencia.

• 
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Premer en Next.

• 

Fixarse na ruta onde vai ser instalado. Premer Next.

• 

• 
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Fixarse onde se vai instalar o JRE.

Proceso de instalación do JRE.

• 

Pechar o proceso de instalación.

• 

Comprobar a versión do JRE: java -version. En cambio a versión do compilador dinos que non atopa o programa javac.

• 

• 
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Iso é porque non está a ruta no path. Non fai falla para executar Eclipse nin o SDK de Android, pero se alguén o desexa pode engadir a ruta
ao path. Observar que no path non aparece a ruta ao JRE, pero no proceso de instalación copiase a MV de Java (java.exe) a
C:\Windows\System32\.

Instalación do IDE Eclipse

A continuación instalarase o IDE de Eclipse, cuxo proceso de instalación é simplemente descargar e descomprimir un paquete, sen máis.• 
En http://eclipse.org/ está o sitio do IDE.• 

Instalación IDE Eclipse• 

En http://www.eclipse.org/downloads/ podemos atopar a última versión. No material usouse á 4.3.1. Hoxe existe a 4.4.1 (Luna).
Descargamos neste caso a versión de 64 bits do IDE de Java EE (Enterprise Edition) por ser máis completa cá do IDE de Java, pero con
esta última tamén sería suficiente.

• 

• 
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Descomprimir o ficheiro.

Carpeta Eclipse que xa contén o IDE, listo ...

• 

Pregunta polo espazo de traballo para os proxectos. A versión do programa é Mars (4.5.0).

• 

• 
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O IDE funcionando. Pero, pero !!!!! Só está dispoñible para o usuario que o baixou e non para os demais do sistema. Isto non é desexable
nunha aula.

IDE Eclipse para tódolos usuarios

Para que o IDE Eclipse estea dispoñible para tódolos usuarios do sistema, só é preciso poñer o cartafol Eclipse nunha ruta accesible por
todo usuario. Neste caso vaise facer uso da máis recomendada C:\Archivos de Programa.

• 

Finalmente crearase un menú para que calquera usuario poida lanzar o IDE dende o Botón de Inicio de Windows.• 

Instalación IDE Eclipse para tódolos usuarios• 

Cortar a carpeta Eclipse.

• 

• 
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Pegala en C:\Archivos de Programa (Program Files).

Premer en continuar para aceptar a advertencia de seguridade.

• 

Crear un atallo ao programa eclipse.

• 

• 
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Renomear o atallo a eclipse e copialo.

Pegalo en C:\ProgramData\Microsoft\Windows\Start Menu\Programs. A carpeta "ProgramData" está oculta e a carpeta "Start Menu" pode
que se chame "Menú de inicio".

• 

Premer en continuar para aceptar a advertencia de seguridade.

• 

• 
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O menú Eclipse xunto con outros accesos directos doutras aplicacións.

Ir a Inicio de Windows e buscar a aplicación Eclipse.

• 

Lanzar o IDE Eclipse

• 

• 
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O Eclipse funcionando.

Instalación Android SDK

O proceso de instalación é semellante ao do IDE Eclipse: descargar un paquete e descomprimilo.• 
En http://developer.android.com/sdk/index.html#Other podemos comezar co proceso de instalación.• 
Poderíamos descargar o Bundle asociado ao noso SO e este xa traería integrado nun só paquete: Eclipse + Android SDK + Plugin ADT. Só
restaría instalar o JRE (ou JDK se se desexa).

Poderíase configurar para que puidera ser usado por calquera usuario do sistema do mesmo xeito que se fixo antes con Eclipse e
que se vai facer a continuación co SDK de Android.

♦ 

• 

Pero, como indicamos, vaise instalar cada compoñente por separado.• 

Instalación Android SDK• 

En http://developer.android.com/sdk/index.html#Other poderemos descargar o SDK para Android. asociado ao noso SO. Neste caso
baixarase o instalador executable do SDK para Windows, fixarse que a versión é a mesma para 32 bits que para 64 bits.

• 

• 

http://developer.android.com/sdk/index.html#Other
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_windows_29.jpg
http://developer.android.com/sdk/index.html#Other
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_windows_30.jpg


Aceptamos as condicións e descargamos.

Executar o instalador.

• 

Aceptar a advertencia de seguridade.

• 

• 
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Premer en Next.

En versións anteriores de Android SDK, o instalador informaba dun erro na localización do ficheiro java.exe. Isto so pasa na versión de 64
bits de Windows. Para solucionalo hai que engadir nas variables de contorno a variable JAVA_HOME apuntando á ruta do SDK.

• 

Premer en propiedades de Este PC.

• 
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Ir a Configuración avanzada do sistema.

• 

Na lapela Opcións avanzadas premer en Variables de entorno.

• 
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Crear unha nova variable de entorno.

• 

Nome da variable: JAVA_HOME e valor da variable, neste caso, c:\Program files\Java\jdk1.7.0_45. Aceptar todo.

• 

• 

https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_windows_38.jpg
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_windows_39.jpg
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_windows_40.jpg


Volver a lanzar o instalador do SDK de Android.

Pódese instalar para o usuario actual.

• 

Fixarse como descomprimiría nunha carpeta do usuario que está no sistema. Pero pola mesma razón de antes con Eclipse, preferimos que
estea dispoñible para todos os usuarios. Premer en Back.

• 

Android SDK para tódolos usuarios

Instalación Android SDK tódolos usuarios• 
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Seleccionar para tódolos usuarios.

• 

Observar a ruta de instalación. Como temos un SO de 64 bits vaino instalar onde se instalan os programas de 32 bits en C:\Program files
(x86)\ na subcarpeta \android\android-sdk. Quen o desexe pode modificar esa ruta, pero senón a modifica o plugin ADT de Eclipse vai
tratar de buscar nesa ruta o SDK por defecto.

• 

• 
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Instalar ...

Premer en Next.

• 

Poderíase lanzar o Xestor do SDK para completar a instalación, pero vaise realizar manualmente.

• 

• 
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Na carpeta C:\Program files (x86)\android\android-sdk podemos lanzar o SDK Manager ou xestor SDK

Hai que lanzalo como Administrador, premendo co botón dereito sobre o programa.

• 

Aceptar a advertencia de seguridade.

• 

• 
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A imaxe pertence a unha versión anterior de Android SDK. Se se preme na imaxe verase en tamaño real, e poderá apreciarse, que aínda
non está o SDK listo para poder crear o noso primeiro programa: precísanse compoñentes que xa marca por defecto o xestor: Unha API
(marca por defecto a última) e compoñentes básicos.

Neste caso, como xa se indicou nun apartado anterior, vanse descargar a API 16. Se se desexa pódese instalar as APIs 4.4W e L (8 GiB a
maiores). Se non é o caso lembrade desmarcalas xa que pode defectos as baixará.

• 

Aceptar as licencias dos compoñentes.

• 

• 
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Ollo!!! que abaixo hai máis licencias para aceptar. E premer en Install

Comezo da descarga. Da un erro de que non pode parar o servidor ADB, porque aínda non está instalado. O servidor ADB verase nun
apartado posterior.

• 

Descarga completada e o servidor ADB funcionando.

• 

• 
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Compoñentes do SDK instalados.

Carpetas creadas e asociadas ao SDK.

• 

NOTA:: Cando decidimos instalar unha nova versión do S.O. Android non é necesario marcar todas as opcións dentro desta API. Así:

SDK: Necesario para poder desenvolver a aplicación. Sempre debe ser marcada.◊ 
Samples for SDK: Documentación de exemplo. Non é necesario marcala.◊ 
System Image (ARM/Intel/MIPS): Cando máis adiante utilicemos un dispositivo virtual para correr as nosas aplicacións, será
necesario ter descargado a lo menos unha destas imaxes. O normal é que se temos un procesador INTEL descarguemos unha
imaxe INTEL xa que despois poderemos instalar un acelerador hardware para dito micro. Se non temos intel poderíamos
descargar calquera das opcións.

◊ 

Google API: O mesmo que o System Image pero para dar soporte a aplicacións que van facer uso de Google Maps. Se non imos
traballar con el non será necesario descargalas.

◊ 

Sources for Android SDK: Fontes das funcións do SDK. Non é necesario descargalas.◊ 

Android Debug Bridge: ADB

O Android Debug Bridge (ADB) é un comando que arranca un servidor que nos vai permitir comunicarnos e interactuar cos dispositivos
físicos ou emulados.

• 

O ADB verase con profundidade nun apartado posterior, por agora so interesa que se poida executar.• 
No enlace hai máis información: http://developer.android.com/tools/help/adb.html• 

Executamos o comando: C:\Program files (x86)\android\android-sdk\platform-tools\adb e amosa a axuda do comando.
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Instalación plugin ADT

Só resta instalar o plugin en Eclipse que permita traballar dende este IDE co SDK de Android.• 
Este plugin chámase: Android Development Tools (ADT) e estende as capacidades de Eclipse para xestionar dispositivos móviles
(emulados e reais), compilar e instalar aplicacións en dispositivos, etc.

• 

En http://developer.android.com/tools/sdk/eclipse-adt.html hai máis información sobre este compoñente e como se pode instalar no IDE.• 

Instalación ADT Plugin• 

En http://developer.android.com/tools/sdk/eclipse-adt.html premer en Installing the Eclipse Plugin

• 

En http://developer.android.com/sdk/installing/installing-adt.html indica que podemos instalar o Plugin de dúas formas:

• 

• 
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Unha descargando o paquete e logo instalalo dende Eclipse ...

... ou copiar o enlace ao repositorio no que se atopa o plugin ADT: https://dl-ssl.google.com/android/eclipse/. Usaremos esta forma.

• 

Lanzar Eclipse.

• 

Premer en Help -> Install New Software...

• 

Pegar o repositorio ... Premer en Add.

• 
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Poñer un nome ao repositorio, neste caso ADT

• 

Amosa o compoñente que se vai instalar. A versión actual amosa só o compoñente Developer Tools. A versión anterior de ADT ofrecía
instalar o compoñente NDK: Native Development Kit que permitía desenvolver aplicacións en linguaxe nativa como C ou C++. Máis
información: http://developer.android.com/tools/sdk/ndk/index.html
Dentro dos compoñentes de Developer Tools hai outros como DDMS que se verá nun apartado posterior.
Unha vez marcado todo premer en Next.

• 

• 
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Premer en Next.

Aceptar a licencia.

• 

Proceso de descarga e instalación dos paquetes.

• 

Aceptar a advertencia que indica que hai software sen asinar.

• 

• 
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Permitir acceso ao Firewall de Windows.

Reiniciar eclipse cando remate a instalación do plugin.

• 

Indicar se se desexa participar nas estadísticas de Google.

• 

Eclipse funcionando.

• 

Configuración Eclipse e plugin ADT. Actualizacións

Agora xa podemos iniciar eclipse sen problemas e imos ver:
Parámetros de configuración de Eclipse.♦ 
Como actualizar Eclipse ou o SDK de Android.♦ 
Que elementos engadiu o plugin ADT á Perspectiva Java de Eclipse.

Unha Perspectiva é unha combinación de pantallas para facilitar o desenvolvemento de aplicacións de distintos tipos.◊ 
Aconséllase que se lle bote un ollo a: "Mi primera hora con Eclipse":
http://ubuntulife.files.wordpress.com/2008/03/intro_eclipse_espanol.pdf

◊ 

♦ 

• 

Preferencias• 
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Premer en Window -> Preferences.

• 

Na categoría Android pódese ver a ruta do SDK, se esta se perdera, con vir a esta preferencia xa se podería configurar.

• 

A versión do compilador JDK que vai usar o IDE.

• 

• 
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A versión do JRE e a súa ruta.

Actualizacións• 

Lanzar o Eclipse como Administrador.

• 

En Help -> Check for Updates.

• 

• 
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Comprobando se hai actualizacións do IDE.

Non hai actualizacións.

• 

Perspectiva Java• 

A combinación de ventás (Perspectiva) que se ve é a que se denomina Java EE.

• 

Pero ADT instalou compoñentes na Perspectiva Java. Premer en Window -> Open Perspective -> Java

• 

Aparecen novas iconas, entre elas, o Android SDK Manager e o Xestor de Dispositivos Virtuais.

• 

• 
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O mesmo pasa se se preme en Window

Dende o propio Eclipse, o plugin proporciona un enlace ao comando que chama ao Xestor de SDK de Android, que estaba na ruta:
C:\Program Files (x86)\android\android-sdk\SDK Manager Dende aquí poderíanse instalar/desinstalar compoñentes e incluso
actualizalos. Pero hai que iniciar o Eclipse como administrador, como se amosa na seguinte imaxe. Non o pode facer un usuario normal salvo
que se modifique a seguridade.

• 

• 
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Iniciar Eclipse como administrador.

Aceptar a advertencia de seguridade.

• 

Carpetas de traballo

As carpetas que se obteñen finalmente pertencen a 2 tipos:
Carpetas de programas:

C:\Program Files\eclipse: Eclipse + plugin ADT◊ 
C:\Program Files (x86)\android\android-sdk: Android SDK◊ 

♦ 

Carpetas de configuración de usuario
C:\Users\usuario\AppData\...: Carpeta oculta. Contén arquivos de configuración relativos a ese usuario e ao IDE
Eclipse.

◊ 

ruta\workspace: Carpeta indicada polo usuario onde se van gardar os proxectos creados no IDE Eclipse.◊ 
C:\Users\usuario\.android: Contén arquivos de configuración relativos ao SDK de Android e a ese usuario.◊ 

♦ 

• 

Fixar a icona á barra de tarefas

Unha forma de facilitar o acceso a eclipse pode ser fixando a icona á barra de tarefas.• 
Hai varias formas de facelo, unha delas é a seguinte, unha vez que se ten o Eclipse lanzado, aparece unha icona na barra de tarefas, premer
co botón dereito sobra a icona e fixar o programa a esta barra.

• 

-- Ángel D. Fernández González e Carlos Carrión Álvarez -- (2015).
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